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Microsoft® Windows XP GSA Image
March 15, 2006 Version 

The following document details the Microsoft® Windows XP GSA image creation process for the Office of the FSS Chief Information Officer, Information Infrastructure Division, Client/Web Services Branch. 
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What’s New?

Deletions
Additions

· Lotus Notes QuickPlace Active-X Plugin

· Jinitiator v.1.1.8.22

· Jinitiator v.1.3.1.25
· Drivers for the Dell Optliplex GX620 desktop

Upgrades

· Upgraded Adobe Acrobat Reader from version 6.0.4 to 7.0.5
· Updated GSA Security Template for Windows XP – March 2006 Release

· Windows XP and Office updates as of March 10, 2006
Image History
Overview

The following information details the chronological history of GSA images.

 GSA Windows XP Image November 15, 2005
Deletions
Additions

Upgrades

· Upgraded Lotus Notes from version 6.0.3 to 6.0.4

· Upgraded Adobe Acrobat Reader from version 6.0.1 to 6.0.4

· Upgraded Microsoft Office 2003 from SP1 to SP2

· Windows XP and Office updates as of November 8th, 2005

 GSA Windows XP Image July 15, 2005
Deletions
None

Additions

· Drivers for the Dell Latitude D410

· Drivers for the Dell Latitude D610
· Drivers for the Dell Latitude D810
Upgrades

· Upgraded Windows XP to Service Pack 2

· Windows XP and Microsoft Office 2003 Updates

· Citrix ICA Client 8.100.29670 Update.

· Real Player Update (build number 6.0.11.1519)

· Updated GSA Security Template files

 GSA Windows XP Image March 15, 2005
Deletions

Additions
Upgrades

· Windows XP and Microsoft Office 2003 Updates.

· Real Player Enterprise (GSA), modified March 2, 2005.
 GSA Windows XP Image November 15, 2004
Deletions

· Office XP uninstalled and Office XP installation files removed from C:\Windows\Options\OF03.
· Pegasys uninstalled. 
· Outlook Express uninstalled.

· RealPlayer 8 Basic 6.0.9.450 uninstalled.
Additions
· Office 2003 installation files copied to C:\Windows\Options\OF03\ and Office 2003 installed from this location.

· Service Pack 1 for Office 2003 installed.
· Real Player Enterprise installed from GSA’s Intranet Web site.

· Drivers for the Dell GX280 added.

Upgrades
· Windows Media Player 10 upgraded from Windows Media Player 9.
· Visio Viewer 2003 upgraded from Visio Viewer 2002.

· Adobe Acrobat Reader 6.0.05 upgraded to version 6.0.1.

 GSA Windows XP Image July 15, 2004
Deletions
None

Additions
· Support for the Dell Latitude X300 laptop

· Windows Critical Updates
Upgrades
· Office XP Service pack 3

GSA Windows XP Image April 1, 2004
Deletions
None

Additions
· ZapNotes version 3.4.2
· Sun Java Client version 1.4.1_02

· Sun Java Client version 1.4.1_03

Updates

· Office XP CD copied to C:\Windows\Options\OF03 and Office XP reinstalled from this location.
 GSA Windows XP Image December 25, 2003

Deletions
None

Additions
· Sun Java Client version 1.4.1
· Sun Java Client version 1.4.2
· Drivers for the Dell Latitude D series
· Additional drivers for all currently supported hardware as requested by the ITAPC
Updates
· Lotus Notes client upgraded to version 6.0.3
· Citrix Client upgraded to version 7.1
· McAfee upgraded to version 7.1
· Windows updates and security patches
· Necessary security modifications requested by the Information Technology Architecture Planning Committee (ITAPC)
· File and print sharing disabled
· Internet Explorer Windows update disabled
· Outlook Express deleted
· Games deleted
· LAN Authentication Manager disabled
· Restricted access to Command Scheduler
· Updated Security INF file
 GSA Windows XP Image April 25, 2003

Updates
· Hot fixes and security updates

Standard Applications
· Proxy 4.0.5

· WinINSTALL Remote 7.0
· Visio Viewer

· Hot fixes and security updates

· Lotus Notes 6.01CF
· McAfee Virus Shield 7.0
· Acrobat Reader 6.0.
· Microsoft Internet Explorer 6.0.2800.1106 service pack 1

· Citrix Neighborhood Client 6.30.1050
GSA Standard Applications

Overview

The following table displays applications that are standard on the Microsoft Windows XP GSA image.

	GSA Standard Windows XP Image (March 2006)

	Windows XP Professional SP2

	Office 2003 SP2(Outlook not installed)

	Lotus Notes Mail Client 6.0.4

	McAfee Virus Shield 7.1.0

	FedDesk (Citrix-dependent Internet shortcut)

	Acrobat Reader 7.0.5

	WinZip 9.0 SR-1 

	PPViewer 7.0

	ZapNotes 3.4.2

	Internet Explorer 6.0.2800.1106

	Citrix Neighborhood/Client 8.100.29670

	Windows Media Player 10.0

	RealPlayer Enterprise (GSA)—build number 6.0.11.1591

	Visio Viewer 2003

	Sun Java Client 1.4.1_02

	Sun Java Client 1.4.2_03

	Jinitiator 1.1.8.22

	Jinitiator 1.3.1.25

	Windows XP and Office 2003 updates as of March 10, 2006


GSA-Supported Desktops and Laptops
The March 15, 2006 version of the Windows XP image currently supports the following desktops and laptops.
 Desktops
· Dell Optiplex GX110

· Dell Optiplex GX150
· Dell Optiplex GX240

· Dell Optiplex GX260

· Dell Optiplex GX270
· Dell Optiplex GX280
· Dell Optiplex GX620
 Laptops

· Dell Latitude C400

· Dell Latitude C600

· Dell Latitude C610

· Dell Latitude C640

· Dell Latitude D400

· Dell Latitude D410

· Dell Latitude D600

· Dell Latitude D610

· Dell Latitude D800

· Dell Latitude D810

· Dell Latitude X300

Creating the Image
Overview

The following information details how the image DVD is created.
 Install Windows XP
Step 1. Download and Upgrade the BIOS
1. Download the latest BIOS update from the computer manufacturer’s Web site.
2. Using the procedures provided from the manufacturer, create a bootable BIOS update disk or follow other recommended method for installation.
3. Update the BIOS and verify.

4. Restart the computer.
Step 2. Prepare Hard Drive

5. Insert GSA image CD and boot machine.

6. Exit GHOST.

7. Run fdisk.exe.

8. Click Y for large disk support.

9. Click Enter.

10. Press 4: Display partition information.

11. Click Enter.

12. Press Esc after partition information is displayed.

13. Press 3: Delete partition or Logical DOS Drive.
14. Click Enter.
15. Select appropriate partition to delete. 
16. Return to main menu when complete.
17. Press 1: Create DOS partition or Logical DOS Drive.

18. Click Enter.

19. Press 1: Create Primary DOS Partition.

20. Click Enter.

21. Press Y to use the maximum available size.

22. Click Enter.

23. When process is complete, press Esc to exit fdisk.

24. Shut down the computer.
Step 3. Install Windows XP Professional

25. Insert Windows XP Professional SP2 CD and boot computer.
26. Press any key to boot from CD-ROM when prompted. If the computer does not boot from the CD-ROM, check the boot order in the BIOS.
27. Click Enter at the Windows XP Professional Setup screen.
28. Click F8 at the Licensing Agreement page.
29. Click the displayed partition.

30. Click Enter.
31. Click Format the partition using FAT file system.
Note: If this option is not available, follow the procedures below to format the hard drive with the FAT file system:

· Exit the setup program.
· Remove the Windows XP CD.
· Insert a GSA image CD and reboot.
· Exit GHOST.
· From a dos prompt, type format c:.
· Click Enter to format the C drive. 
· After the format is complete, remove the GSA image CD or DVD, reinsert the Windows XP CD, and restart the computer.
· Follow the above steps for installing Windows XP. When the partition is displayed, arrow down to Leave the current file system intact , <no changes> and click Enter.
32. Setup will copy files to the windows installation folders, after which the computer restarts and the Graphic Interface portion of the installation begins.
33. When prompted, click Next at the Regional and Language Options Screen.
34. Type GSA in both the Name and Organization fields on the Personalize Your Software screen. 
35. Click Next.
36. Enter the Product Key.

37. Click Next.
38. Enter the Computer Name.
39. Enter the administrator password in both the Administrator Password and Confirm Password boxes.

40. Click Next.
41. Verify the information in the Date and Time and the Time Zone fields and change if necessary. 
42. Verify the Automatically adjust clock for daylight saving changes check box is selected. 
43. Click Next.

44. Setup will continue copying files and the computer will automatically reboot when complete. 
45. After reboot, click OK in the Display Settings box.

46. Click OK in the Monitor Setting box.
47. Click Next at the Welcome screen.
48. At the Who will use this computer? screen, type GSA User in the Your Name Box.

49. Click Next.
50. Click Finish at the Thank You screen.
51. Click Start.

52. Click Control Panel.
53. Click User Accounts.
54. Click GSA User under Pick an Account to Change.
55. Click Create a Password for Your Account.
56. Type the password and then confirm it (ignore the password hint box).

57. Click Create Password.
58. Close the User Accounts screen.
59. Close Control Panel.
60. Log off.
61. Log on as GSA User.
62. From Start, click Control Panel.
63. Click Switch to Classic View in the left pane of the control panel screen.

64. Double-click System.
65. Click the Hardware tab.
66. Click Device Manager.
· Carefully view all devices and install the drivers for the devices without drivers. 

· When complete, there should not be devices with yellow exclamation marks beside them. 

· These drivers should be downloadable from the computer manufacturer’s Web site or from CDs accompanying the computer when shipped. 

· You may be prompted to restart the computer after each driver is installed. If prompted, restart the computer and continue through completion. 

· After all drivers are installed, reboot and log in as GSA User.

Step 4. Install Windows Critical and Security Updates, and Service Packs
67. Verify your network card is functioning and you have a connection to a network with Internet access.

68. From the Start Menu, click on Programs..
69. Click on Internet Explorer.
70. Type www.microsoft.com in the Address window
71. Press Enter

72. Click on Microsoft Update
73. Click the Custom button to install and follow the instructions to download and install critical and security updates. 
74. Click Review and Install Updates to install additional components necessary for the custom install. Restart if prompted after the update is complete.

75. After the computer restarts, repeat the steps above. 
· Click Custom and verify all the High Priority Updates. 
· Click Review and Install updates. 
· If prompted to restart after an update is complete, restart and repeat steps above and check for uninstalled updates until there are no updates available. 
· After initial reboot, repeat the steps above to install optional software updates.
 Install Applications

Step 5. Install Microsoft Office 2003
1. Log in as GSA user with the appropriate password.

2. Install:

· Insert Microsoft Office 2003 Installation CD.

· Cancel the Installation if it automatically starts after the CD is inserted.

· From the Windows Explorer screen, choose Tools and Folder Options.

· Click the View tab.

· Verify that all hidden files and folders are shown and protected operating system files are not hidden. 

· Copy entire contents of CD to C:\WINDOWS\Options\OF03 (the Options and OF03 folder need to be created prior to copying).

· Remove Microsoft Office 2003 Installation CD.

· Browse to C:\WINDOWS\Options\OF03 and run SETUPPRO.EXE.

3. Type the Product Key and press Enter.
4. Type GSA User for user name and GSA as Organization.

5. Click Next.

6. Select the check box at the bottom of the screen to accept the license agreement.

7. Click Next.

8. Click Custom Install.
9. Click Next.
10. Clear the check box beside Outlook from the list of applications to be installed, and select the check box beside Choose advanced customization of applications.
11. Click Next.
12. For all applications and tools listed in Advanced Customization (with the exception of Microsoft Office Outlook, which should have an X beside it), click once on each tool and select Run all from My Computer from the drop-down list. 
13. When complete, click Next.
14. Click Install from the Summary screen.

15. When setup is complete, verify the following checkboxes are not selected:

· Check the Web for updates and additional downloads

· Delete installation files

16. Click Finish.

Step 6. Update Microsoft( Office 2003
17. Click the Microsoft( Internet Explorer icon.

18. Navigate to www.microsoft.com.

19. Click on Microsoft Update.

20. Click the Office Update tab from the top row menu.

21. Click Check for Updates.
22. If prompted, click Yes to install and run the Office Update Installation Engine.

23. Click the Start Installation button and follow the instructions provided to install the updates.

24. When the installation is complete, verify SP 2 and the other upgrades were installed successfully.

25. Click Finish.

26. Close the Internet Explorer window.

Step 7. Configure Microsoft( Office 2003
27. Open all Microsoft Office Applications and test functionality.

28. Open Microsoft( Word.

29. From the Tools menu, click Macro, and then click Security.

30. Click Medium.
31. Click OK.
32. When testing is complete, close all Microsoft Office Applications.
Step 8. Setup RealPlayer
1. Launch Internet Explorer.
2. Navigate to http://insite.gsa.gov/downloads/.

3. Follow the procedures to download and install Real Player.

Step 9. Install Lotus Notes

33. Obtain a copy of the Lotus Notes Installation CD version 6.0.4.
34. Insert CD; Autorun should automatically start the installation.
35. Click Install.
36. Click Next.

37. Click I accept the terms in the license agreement.

38. Click Next.

39. Verify the User Name is GSA and the Organization is GSA.

40. Click Change under Install program files to and change the path to c:\program files\notes\. 

41. Click Change under Install data files to and change the path to c:\program files\notes\data\.

42. Click Next.
43. Verify the check box beside Make Notes my default email program is selected. 
44. Click Install.

Step 10. Install Feddesk

45. Locate the FEDDESK.ICO file from a previous FSS or GSA image located in the C:\winnt\system32 directory. 
46. Copy to the c:\winnt\system32 directory on your computer.
47. Click the Internet Explorer icon.
48. Ensure the following URL works properly: http://feddesk.gsa.gov 
49. From the Explorer main menu, click File, Send.

50. Click Shortcut to Desktop.

51. Right-click the FEDdesk shortcut on the desktop:
· Click Properties.

· Click Change Icon.

· Type C:\winnt\system32\feddesk.ico.

· Click within the Current icon box. 

· Verify the FEDdesk icon appears.

· Click OK. 

· Click Apply.

· Click OK to close the FEDdesk Properties window.

· Move the FEDdesk shortcut from the desktop to the task bar.

Step 11. Install WinZip 9.0 SR-1

52. Launch Internet Explorer.

53. Navigate to http://insite.gsa.gov/downloads/
54. Click WinZip 9.0 SR-1 link.

55. Click the WinZip 9.0 link (updated September 4, 2004).

56. Click Save and save wzsite90.exe to a temporary location.

57. Click Close to close the Download Complete window.

58. Browse to the temporary location and double-click the wzsite90.exe file.

59. Click Setup.

60. Click OK to install to C:\Program Files\WinZip.

61. Click Next at the Winzip Setup screen.

62. Click Yes to accept the license agreement.

63. Click Next.

64. Click Start with WinZip Classic.

65. Click Next.

66. Click Express Setup. 

67. Click Next.

68. Click Next to associate with archives.

69. Click Finish. 

70. Click Close to close the installation window.
71. Close Winzip.
Step 12. Install Citrix Program Neighborhood

72. Launch Internet Explorer

73. Navigate to http://ras.gsa.gov.
74. Position the cursor over, Downloads.
75. Click on the Citrix Browser Plugin option from the drop down list that appears..

76. Click on the Download link below the Metaframe Client 8.x.

77. Click Save from the File Download screen and save file to a temporary location.

78. Browse to the temporary location.

79. Double-click the Citrix8.msi and accept the default settings to install..

80. Click Finish when the installation is complete.

Step 13. Install Adobe Acrobat Reader 7.0.5
81. Launch Internet Explorer.

82. Navigate to http://insite.gsa.gov/downloads/
83. Follow the procedures to download and install Adobe Acrobat Reader.
Step 14. Install PaperPort Viewer 7.0

84. Navigate to http://www.scansoft.com/paperport/viewers/
85. Click the executable for The PaperPort Viewer for Windows.

86. Follow the instructions to download and install.

87. Accept all defaults during installation and restart computer after installation.

Step 15. Install ZapNotes

88. Go to http://www-10.lotus.com\ldd\sandbox.nsf 

89. Click Search the Sandbox.

90. Type ZapNotes in the Search box.

91. Click the ZapNotes 3.4 link and download the installation executable.

92. Double-click the downloaded executable.
93. Click Next at the prompt “Welcome to ZapNotes Setup program.”

94. Click Next.

95. Click Next twice.

96. Click Finish.

Step 16. Install Visio Viewer

97. Navigate to http://www.microsoft.com/downloads/
98. Type “Visio Viewer” in the keyword box.

99. Click Go.

100. Click Visio Viewer 2003.

101. Follow the instructions to download.

102. Double-click vviewer.exe.

103. Select “I agree the terms in the License Agreement.”

104. Click Install.

105. Click Finish.

Step 17. Install McAfee Anti-Virus

106. Launch Internet Explorer.

107. Go to http://insite.gsa.gov/downloads/
108. Click McAfee VirusScan Enterprise 7.1.

109. Click VirusScan Enterprise 7.1.0 in the VirusScan Enterprise for Windows NT/2000/XP Workstations and Servers column.

110. Save the zip file to a temporary location.

111. Extract files from the zip file.

112. Run setup.exe using default settings.

 Finalize Image

Step 18. Clean System

113. Delete all unnecessary icons from the Desktop and Start Menu.
114. Remove all unnecessary files and clean directories.
115. Defragment hard drive.
116. Open Windows Explorer. 

117. Choose Tools and Folder Options. 
118. Click the View tab and verify that hidden files and folders are not shown and that protected operating system files are hidden. 

Step 19. Change Boot Delay to “0”

119. Click Start.
120. Click Control panel.
121. Click System.
122. Click Advanced.
123. Click Startup and Recovery.
124. Click Settings.
125. Delete 30 seconds and replace with 0 for “Display of Operating System.”

126. Click OK.
 Run SysPrep

Step 20. Configure System (System setup to change to NTFS)

127. Copy system preparation tools and files to C:.
128. Run Sysprep.bat.
129. Turn off system.
Step 21. Create System Image

130. Boot system with network boot disk.
131. Run ghost.exe.
132. Create image to file.
133. Use high compression.
134. Check image file when complete.
Step 22. Configure Image for Approved Systems

135. Load image on next system.
136. Update needed drivers (downloaded drivers are in C:\windows\options\drivers).
137. Repeat on next system.
Step 23. Create GHOST CD

138. Use GHOST Explorer to span image to as many as needed 625 megabytes files.
139. Create bootable CDs with ghost.exe and image file.
GHOSTing the Image
The following instructions detail the GHOSTing process for Microsoft( Windows XP Professional for both desktop and laptop computers.

 Set Up Workstation BIOS

1. Install special hardware into the new PC. 

2. Boot the new PC.

3. Enter BIOS setup of PC. 

4. Press F2 while the Dell splash screen is visible on the system boot-up.

5. Change the boot device order to reflect the CD-ROM drive as the primary boot device. 

· For Dell desktops:

· Arrow down to the boot sequence.

· Press Enter.
· Arrow down to the IDE CD-ROM device line.

· Use the minus key to move the line to the top of the list.

· Press Escape to exit from this screen.

· Press Escape to exit from the Setup utility.

· Press Enter at the Save Changes prompt.

· The system should reboot.

· For Dell notebooks: 

· Press ALT+P to move to the secondary setup screen.

· Arrow down to the CD-ROM device line.

· Use the “u” and “d” keys to move the CD-ROM device line above the INTERNAL HDD line.
· Insert the reimaging disc into the CD-ROM drive.

· Press Escape to exit setup. 

· Highlight Yes and press Enter if prompted to save changes
 Imaging a PC

Ensure the computer is backed up before proceeding with the following process. If the computer is not new, make sure to back up the data. 

1. Insert the imaging CD into the CD-ROM drive.

2. Click Escape to reboot.

3. Click Enter to bypass the splash screen.

4. A menu appears. 

5. Using the arrow keys, click OK to dismiss the splash screen.

6. A pop-up menu will appear.

7. Click Local.
8. Click Disk.

9. Click From Image.

10. Click Enter.

11. Click OK.

12. Click the source image. Only one source image will appear; it is already selected.

13. Click OK.

14. A destination window appears. 

15. Click OK to select the default destination.

16. At the next screen, which is the drive detail screen, press the tab key twice to highlight “Click OK.”

17. Click Enter.

18. A confirmation message appears defaulted to No.
19. Press the tab key once to highlight Yes.
20. Click Enter.

21. The imaging process begins.

22. If the imaging process prompts for additional CDs, put them into the CD-ROM and click OK. 

23. After imaging is complete, remove the CD.

24. Press a key to reboot the PC.

25. When the PC starts with a fresh image, a dialog box “A duplicate name exists on the network”
 may appear if the PC is connected to the network. (This message only appears if the computer is attached to a network; the new image has a generic name if more than one machine on the network is being imaged.) Enter any unique name; the proper name will be added later.

26. Wait for the hardware scan to complete; the PC again reboots and automatically begins installing devices and the conversion process. This takes a few minutes. The system automatically restarts and begins converting the file system from FAT32 to NTFS. 

27. The computer reboots.

28. Bring this PC to the appropriate user location for customer-specific configuration.

Configure New PC

The following steps outline how to begin configuration of a freshly imaged computer: 
1. Plug new equipment (i.e., keyboard, mouse, speaker, etc.) into the new PC.

2. Log on to the new PC:

3. Log on as “GSA User” with the appropriate password.
4. Click OK.

5. Change the computer name:
· Right-click My Computer.

· Click Properties.
· Click the Computer Name tab.

· Click Change.
· Type the computer name, which is the site name, a hyphen, and the Dell service tag number (e.g., FCOH1W-C9FRZ11; where FCOH1W identifies the site location and C9FRZ11 identifies the system serial number or Dell service tag number). This sets the NetBIOS name.
· Type the workgroup name (FSS). 

· The computer name or NetBIOS name must be registered with the LAN/Server Services Branch before the user can join the domain. Contact the LAN/Server Services Branch to validate the computer is registered.

6. Click OK. There will be a short delay while this information is recorded in the systems registry.

7. Reboot the workstation.
 Apply GSA Security Template

Instructions for implementing Windows XP Professional security template and batch file.

1. Launch Internet Explorer and go to insite.gsa.gov

2. Click on Information Technology.

3. Click on IT Security.

4. Click on Technical Guides and Standards.

5. Click the IT Security Procedural Guide: Windows XP Professional Hardening (CIO IT Security 03-23) 03/03/2006, Revision 6a link.

6. Save the zip file to a temporary location.

7. Extract the files from the zip and copy the inf file to the c:\windows\security\templates directory.

8. Launch the Microsoft Management Console (MMC) by typing “mmc” in the Run execution window.

9. From the Console window, click File, Add/Remove Snap.

10. Click Add.

11. Select the Security Configuration and Analysis module.

12. Click Add, Close.

13. Click OK in the Add/Remove Snap-in window.

14. Right-click Security Configuration and Analysis under Console Root folder. 

15. Select Open Database and provide a name for the new database. 

16. Click Open.

17. Traverse to the c:\windows\security\templates directory where “GSA Mar 03 2006 - WinXP Enterprise-Mobile and Desktop.inf” file is saved. 

18. Select the file and click Open.

19. Right-click Security Configuration and Analysis under Console Root folder.

20. Select Configure Computer Now.

21. Click OK for location of log file. The MMC will now implement the security settings for the workstation.

22. When process is complete, close the MMC.

Frequently Asked Questions
1. Where are the drivers for hardware devices located?

The drivers for hardware devices are located in the C:\windows\options\drivers\dell directory. You will need to search the subfolders within this directory for the device for your model computer.

2. Where are the Windows XP cab files located?

The cab files are located in the C:\Windows\Options\I386 directory.
3. Is Microsoft Publisher now included in the Windows XP image? 
Microsoft Publisher is integrated in the Microsoft Office 2003 suite and is therefore installed in our new Windows XP image with Office 2003. It was not a part of the Microsoft Office XP suite and was not included in the earlier versions of Windows XP image. 
4. Is the Windows Update feature automatically enabled on the image?

The Windows Update feature has been disabled on the image to provide more centralized testing and installation before the updates are deployed to the user community.
5. Where are the Office 2003 installation files located?

The Office 2003 files are located in the C:\Windows\Options\OF03 directory.
6. After imaging a Dell GX1 computer, there were multiple devices without drivers in Device Manager.
The GX1 image has been phased out from our list of supported images. As a result, if our images are used on this model or on any unsupported models, additional drivers need to be installed after imaging, and full functionality is not guaranteed. We recommend that our images be used only on the models we have fully tested and currently support. The list of our supported images is outlined in both the Windows XP and 2000 Image documentation.

7. Lotus Notes is installed under C:\Program Files\Notes, instead of the default location C:\Program Files\Lotus\Notes, for Notes 6 standard. 

C:\Program Files\Lotus\Notes is the default path for the Notes 6 Install. We are using 
C:\Program Files\Notes because a shorter directory path is more beneficial in our organization due to the path limitations of some of our deployment and software distribution tools.
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� The exact message in the dialog box is as follows: “The name for this computer that you specified earlier in the setup, ‘GSA-SYSTEM,’ is already assigned to another computer on the network. Please choose another name.”





